WARNING
Read this entire manual and all other publications pertaining to the work to be performed before installing, operating, or servicing this equipment. Practice all plant and safety instructions and precautions. Failure to follow instructions can cause personal injury and/or property damage.

The engine, turbine, or other type of prime mover should be equipped with an overspeed shutdown device to protect against runaway or damage to the prime mover with possible personal injury, loss of life, or property damage.

The overspeed shutdown device must be totally independent of the prime mover control system. An overtemperature or overpressure shutdown device may also be needed for safety, as appropriate.

CAUTION
To prevent damage to a control system that uses an alternator or battery-charging device, make sure the charging device is turned off before disconnecting the battery from the system.

Electronic controls contain static-sensitive parts. Observe the following precautions to prevent damage to these parts.

- Discharge body static before handling the control (with power to the control turned off, contact a grounded surface and maintain contact while handling the control).
- Avoid all plastic, vinyl, and Styrofoam (except antistatic versions) around printed circuit boards.
- Do not touch the components or conductors on a printed circuit board with your hands or with conductive devices.

IMPORTANT DEFINITIONS

WARNING—indicates a potentially hazardous situation which, if not avoided, could result in death or serious injury.

CAUTION—indicates a potentially hazardous situation which, if not avoided, could result in damage to equipment.

NOTE—provides other helpful information that does not fall under the warning or caution categories.
Contents

CHAPTER 1. UNDERSTANDING THE SYSTEM .............................................1
  System Basics .............................................................................................1
  APECS Controller ..........................................................................................2
  Calibration Tool (ACT) ..................................................................................3
  Speed Sensor ..................................................................................................3
  Actuator ..........................................................................................................3
  Linkage ...........................................................................................................4

CHAPTER 2. INSTALLING THE HARDWARE ........................................6
  Wiring Guidelines ............................................................................................5
  Wiring Lengths ...............................................................................................6
  Controller Installation ....................................................................................7
    Controller Wiring ..........................................................................................7
  Speed Sensor Installation ..............................................................................8
    Guidelines .....................................................................................................8
  Actuator & Linkage Installation ....................................................................9
  Engine Protection Input Wiring ...................................................................10
    Optional Feature ..........................................................................................10
  Speed Select Switch Wiring .........................................................................11
    Optional Feature ..........................................................................................11
    Switch Wiring ...............................................................................................11
  Remote Status Lamp Wiring .........................................................................13
    Optional Feature ..........................................................................................13

CHAPTER 3. CALIBRATION TOOL (ACT) OPERATION .......................14
  ACT Installation .............................................................................................14
    ACT Kit Contents ..........................................................................................14
    Set-up Requirements ....................................................................................14
    Hardware Set-up ..........................................................................................14
    Software Set-Up ...........................................................................................15
  Basic ACT Operation ....................................................................................16
    Running the ACT Software .........................................................................16
    Progress Display Screen .............................................................................16
    Moving Around the Software .....................................................................16
  ACT Menus & Options ..................................................................................17
    ACT Menu Structure ....................................................................................17
  File Menu ......................................................................................................18
    Purpose .........................................................................................................18
    Save APECS Cal to File ...............................................................................18
    View Cal File Comments ............................................................................20
    View Text File ..............................................................................................20
    Convert Commands .......................................................................................20
    Convert APECS Cal to Text ..........................................................................21
    Convert Cal File to Text ...............................................................................21
    Convert Cal File to Strategy .........................................................................21
  Calibrate Menu .............................................................................................22
    Change APECS Calibration .........................................................................22
    Download Cal File to APECS .......................................................................23
    Compare APECS Cal to File Cal ....................................................................24
    Change APECS Password ............................................................................26
    APECS Calibration Wizard ..........................................................................27
  Monitor Menu ...............................................................................................28
    Parameter View ...........................................................................................28
    Parameter Plot .............................................................................................29
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Faults</td>
<td>30</td>
</tr>
<tr>
<td>Control Strategy</td>
<td>31</td>
</tr>
<tr>
<td>Parameter List</td>
<td>31</td>
</tr>
<tr>
<td>Configure Menu</td>
<td>32</td>
</tr>
<tr>
<td>Configure Serial Port</td>
<td>32</td>
</tr>
<tr>
<td>Help Menu</td>
<td>33</td>
</tr>
<tr>
<td>Help Topics</td>
<td>33</td>
</tr>
<tr>
<td>About ACT</td>
<td>33</td>
</tr>
<tr>
<td>User’s Manual</td>
<td>33</td>
</tr>
<tr>
<td>CHAPTER 4. CALIBRATION PROCEDURES</td>
<td>34</td>
</tr>
<tr>
<td>Calibration Guide</td>
<td>34</td>
</tr>
<tr>
<td>Safety Precautions</td>
<td>34</td>
</tr>
<tr>
<td>Calibrating an APECS Unit</td>
<td>34</td>
</tr>
<tr>
<td>Saving a Calibration Set to File</td>
<td>35</td>
</tr>
<tr>
<td>Calibrating an APECS Unit with a Saved Calibration File</td>
<td>35</td>
</tr>
<tr>
<td>Understanding APECS Calibration Parameters</td>
<td>36</td>
</tr>
<tr>
<td>Frequently Asked Questions</td>
<td>36</td>
</tr>
<tr>
<td>List of Parameters</td>
<td>37</td>
</tr>
<tr>
<td>Governor Gain Calibration Parameters</td>
<td>38</td>
</tr>
<tr>
<td>Engine Set Speed Calibration Parameters</td>
<td>40</td>
</tr>
<tr>
<td>FAQ</td>
<td>43</td>
</tr>
<tr>
<td>Questions About Set Speed Calibration</td>
<td>43</td>
</tr>
<tr>
<td>Speed Input Configuration Parameters</td>
<td>43</td>
</tr>
<tr>
<td>FAQ</td>
<td>44</td>
</tr>
<tr>
<td>Questions About PULSES_PER_REV</td>
<td>44</td>
</tr>
<tr>
<td>Engine Start Calibration Parameters</td>
<td>45</td>
</tr>
<tr>
<td>Diagnostics Calibration Parameters</td>
<td>45</td>
</tr>
<tr>
<td>FAQ</td>
<td>46</td>
</tr>
<tr>
<td>How does Overspeed Work?</td>
<td>46</td>
</tr>
<tr>
<td>Actuator Output Calibration Parameter</td>
<td>47</td>
</tr>
<tr>
<td>CHAPTER 5. APECS TROUBLESHOOTING PROCEDURES</td>
<td>48</td>
</tr>
<tr>
<td>General Checklist</td>
<td>48</td>
</tr>
<tr>
<td>Status Lamp/Fault Codes</td>
<td>48</td>
</tr>
<tr>
<td>Glossary of Technical Terms</td>
<td>50</td>
</tr>
<tr>
<td>CHAPTER 6. SERVICE OPTIONS</td>
<td>51</td>
</tr>
<tr>
<td>Product Service Options</td>
<td>51</td>
</tr>
<tr>
<td>Replacement/Exchange</td>
<td>51</td>
</tr>
<tr>
<td>Flat Rate Repair</td>
<td>52</td>
</tr>
<tr>
<td>Flat Rate Remanufacture</td>
<td>52</td>
</tr>
<tr>
<td>Returning Equipment for Repair</td>
<td>52</td>
</tr>
<tr>
<td>Packing a Control</td>
<td>52</td>
</tr>
<tr>
<td>Return Authorization Number</td>
<td>53</td>
</tr>
<tr>
<td>Replacement Parts</td>
<td>53</td>
</tr>
<tr>
<td>How to Contact Woodward</td>
<td>53</td>
</tr>
<tr>
<td>Engineering Services</td>
<td>54</td>
</tr>
<tr>
<td>Technical Assistance</td>
<td>55</td>
</tr>
</tbody>
</table>
Chapter 1. Understanding the System

System Basics

APECS is an acronym for Advanced Proportional Engine Control System. It provides a means of controlling engine speed by adjusting the fuel control lever with an actuator. The heart of the system is a powerful microprocessor-based controller that processes the signal received from a speed sensor and compares it to the desired speed setting.

The output of the controller is a pulse-width modulated signal that drives a precision proportional actuator connected to the engine’s fuel control lever. The actuator converts the signal to an output shaft position, proportional to the duty cycle of the pulse-width modulated signal.

The APECS system provides isochronous engine governing (i.e., engine speed is maintained at the commanded setting, regardless of load) through a wide speed range. APECS is suitable for use on both compression ignition (diesel) and spark ignition (gasoline, CNG, LPG) engines.

Woodward developed the APECS system for a variety of on- and off-highway applications. Typical applications include generator sets, compressors, construction machinery and farm vehicles.

WARNING
An overspeed shutdown device, independent of the APECS system, should be provided to prevent loss of engine control that may cause personal injury or equipment damage.

Figure 1. APECS Engine Control System
System Components

The five main components of the system are the APECS controller, calibration software (ACT), speed sensor, actuator, and linkage. Each component contributes to the overall performance of the system and shortcomings in any of the components will detract from total system performance.

APECS Controller

The APECS 3000 series controller is an isochronous engine governor that provides a means of controlling and limiting engine speed by adjusting the fuel control lever with a proportional actuator. The APECS controller may be programmed to operate at up to four different speeds.

The controller is software programmable and has no manual adjustments. A calibration tool (ACT) is used for programming (configuring and adjusting) the APECS 3000 controller.

Figure 2.
APECS Controller with Calibration Tool Connector

The following features are standard on all APECS 3000 models:

- Isochronous speed control
- Variety of speed signal inputs: magnetic pickup, Hall Effect, coil-type ignition, magneto ignition
- Calibrations set with a personal computer
- Easy to calibrate with APECS start-up wizard
- Calibration tool graphs engine speed on screen, in real time, during calibration process
- All settings remain in memory during shutdown
- Engine protection input protects against adverse conditions such as loss of engine oil pressure or excessive coolant temperature
- Overspeed/underspeed protection
- PID gain adjustment allows governor response to be adjusted by user
- Remote speed control available with external switches:
  - Preprogram up to four discrete speeds and set ramp rates between speeds, or
  - Manually increase/decrease engine speed at preset rates
- Operates on 12 and 24 volt systems
- Compatible with all Woodward proportional actuators
Calibration Tool (ACT)

ACT is a PC (personal computer) based software calibrating and monitoring tool. ACT is designed specifically for use with engines equipped with the APECS 3000 controller. The tool can be run on any IBM compatible computer that meets the requirements listed in Chapter 3 under “ACT Installation.”

Once the APECS 3000 controller has been programmed, ACT may be disconnected. The APECS 3000 unit will continue to operate normally with ACT either connected or disconnected.

Speed Sensor

APECS 3000 monitors engine speed continuously. Engine speed may be sensed by monitoring the frequency of spark events in spark-ignition engines or through the use of a sensor that detects the passing of teeth on an engine driven gear (e.g., flywheel).

Four versions of APECS 3000 are available, each intended for use with a specific type of engine speed sensing:

- Model 3100 (magnetic pickup)
- Model 3200 (spark ignition system)
- Model 3300 (magneto ignition system)
- Model 3400 (Hall Effect input)

Actuator

The actuator converts a pulse-width modulated signal received from the controller to an output shaft position proportional to the duty cycle of the pulse-width modulated signal.

The actuator is mounted on the engine and connected to the control lever by a mechanical linkage.

NOTE

On spark ignition engines, the control lever is usually the throttle lever. On compression ignition engines (diesels), the control lever is usually one of the mechanical governor levers (either shutoff or governor).
Linkage

![Linkage Hardware](image)

The linkage connects the actuator shaft to the engine control lever. A good linkage allows for misalignments and contributes to accurate, stable and responsive performance with minimal play or friction.

Figure 6. Linkage Hardware available from Woodward

**NOTE**

The scope of this manual does not include selection and installation of speed sensors, actuators, or linkages that Woodward offers for use with the APECS system. Information is available on our website at [www.woodward.com](http://www.woodward.com).
Chapter 2.
Installing the Hardware

When installing the APECS hardware, be aware that some of the options selected may also require hardware setup (see list below). Hardware required for optional features is not provided or sold by Woodward.

Take adequate protection to ensure personal and equipment safety and follow the suggested installation sequence given below:

Install main components:
- Review Wiring Guidelines
- Install Controller
- Install Speed Sensor
- Install Actuator and Linkage

Install optional components (hardware installation required):
- Engine Protection Input
- Speed Select Switch
- Remote Status Lamp

Detailed instructions for installation and wiring are provided in the following pages.

Wiring Guidelines

1. To install and wire the controller refer to Figures 7 & 8, and Tables I & II.

2. Power leads are to be connected directly to a switched power source (i.e., battery). Use of a 10 amp, slow-blow fuse is recommended in the battery (positive) wire.

3. Use proper gauges of wire as shown in Table I. Wire insulation should be appropriate for engine applications.

4. Mount the unit in a location where the effects of vibration and temperature are within the specified range. Operating temperature: -40°F to +185°F (40°C to +85°C); vibration: 6 G’s from 40 to 2000 Hz. (See Figure 7 for controller dimensions.)
5. A short to ground fault of the actuator wires could result in an overspeed condition. Use of convoluted tubing, conduit or other wire shielding is recommended to minimize the likelihood of mechanical damage to these wires.
Cautious routing of actuator wires is critical to avoid sharp edges, pinching and wear.

6. Elevated resistance in wires or terminations can result in limited current to the actuator, which will prevent full actuator travel. To avoid these problems, it is important to use good quality terminations and proper crimping technique.
Terminations must be impervious to moisture to prevent shorts and corrosion.

7. Use shielded cable for external speed signal source. Shields should be connected to the battery ground wire at one end only.

Wiring Lengths

Excessive resistance in the wiring will result in insufficient force from the actuator. Such increased resistance can result from too much wire length, inadequate wire gauge, or poor connections.

The following table shows the recommended gauges and maximum lengths of connecting wires for different size APECS actuators. Wire length is the total length (to and from) used to connect the actuator to the controller and the controller to the system power.

NOTE
All system wiring should be twisted pair and shielded (preferably foil shielded).

<table>
<thead>
<tr>
<th>ACTUATOR*</th>
<th>AWG 14 (2.50 mm²)</th>
<th>AWG 16 (1.50 mm²)</th>
<th>AWG 18 (1.00 mm²)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0175</td>
<td>66 ft (20 m)</td>
<td>33 ft (10 m)</td>
<td>22 ft (6.7 m)</td>
</tr>
<tr>
<td>0250</td>
<td>46 ft (14 m)</td>
<td>23 ft (7 m)</td>
<td>15 ft (4.6 m)</td>
</tr>
<tr>
<td>0300</td>
<td>46 ft (14 m)</td>
<td>23 ft (7 m)</td>
<td>15 ft (4.6 m)</td>
</tr>
</tbody>
</table>

(*) The controller has a working range of 9-30 Vdc. However, the actuator must be selected for either 12 or 24 Vdc charging system.
Controller Installation

Controller Wiring

The controller can be installed in the engine compartment (maximum temperature 185°F/85°C.)

![Figure 7. APECS 3000 Dimensions](image)

Table 2. Controller Wiring

<table>
<thead>
<tr>
<th></th>
<th>MODEL 3100</th>
<th>MODEL 3200</th>
<th>MODEL 3300</th>
<th>MODEL 3400</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>BATTERY</strong></td>
<td>Red +</td>
<td>Red +</td>
<td>Red +</td>
<td>Red +</td>
</tr>
<tr>
<td></td>
<td>Black -</td>
<td>Black -</td>
<td>Black –</td>
<td>Black –</td>
</tr>
<tr>
<td><strong>ACTUATOR</strong></td>
<td>White +</td>
<td>White +</td>
<td>White +</td>
<td>White +</td>
</tr>
<tr>
<td></td>
<td>White/Black -</td>
<td>White/Black -</td>
<td>White/Black –</td>
<td>White/Black –</td>
</tr>
<tr>
<td><strong>SPEED SIGNAL INPUT</strong></td>
<td>MAGNETIC PICKUP</td>
<td>IGNITION INPUT</td>
<td>MAGNETO</td>
<td>HALL EFFECT</td>
</tr>
<tr>
<td></td>
<td>Blue +</td>
<td>Blue Coil A</td>
<td>Blue +</td>
<td>Blue: Signal</td>
</tr>
<tr>
<td></td>
<td>Green -</td>
<td>Green Coil B *</td>
<td>Green -</td>
<td>Black: Ground</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tan Coil C *</td>
<td></td>
<td>Red: Sensor power</td>
</tr>
<tr>
<td><strong>SPEED SELECT 1</strong></td>
<td>Violet</td>
<td>Violet</td>
<td>Violet</td>
<td>Violet</td>
</tr>
<tr>
<td><strong>SPEED SELECT 2</strong></td>
<td>Gray</td>
<td>Gray</td>
<td>Gray</td>
<td>Gray</td>
</tr>
<tr>
<td><strong>ACT CONNECTOR</strong></td>
<td>Yellow Tx</td>
<td>Yellow Tx</td>
<td>Yellow Tx</td>
<td>Yellow Tx</td>
</tr>
<tr>
<td></td>
<td>Orange Rx</td>
<td>Orange Rx</td>
<td>Orange Rx</td>
<td>Orange Rx</td>
</tr>
</tbody>
</table>

(*) Optional
Speed Sensor Installation Guidelines

There are four different speed-sensing devices that can be used with the APECS 3000 system.

The APECS controller’s per matching sensors are:

- Model 3100, magnetic pickup input
- Model 3200, spark ignition input
- Model 3300, magneto input
- Model 3400, Hall Effect input

Refer to Table 2, Controller Wiring and Figure 8, Wiring Diagram for guidance in selecting the speed sensor suitable for your controller and application.
For Models 3100 and 3400, the mounting of the sensor unit must be rigid; excessive vibration can cause erroneous signals and unreliable performance.

Use twisted pair shielded wire for all speed sensor wiring. Shield should be grounded at the controller only.

**Magnetic Pickup**  
Used with Model 3100

Installed opposite an engine driven gear such as the flywheel, it transmits a signal each time the magnetic flux path across the pole is interrupted by a gear tooth.

**Spark Ignition**  
Used with Model 3200

Intended for either traditional coil and distributor ignition or distributorless ignition systems.

**Magneto Ignition**  
Used with Model 3300

Typically found on small 1- and 2-cylinder engines.

**Hall Effect**  
Used with Model 3400

Located next to an engine driven gear

**NOTE**  
It is beyond the scope of this manual to discuss detailed speed sensor selection and installation for all possible applications. Please contact the factory for specific information concerning your application.

**Actuator & Linkage Installation**

1. Select actuator with sufficient force to move the fuel control lever from minimum to maximum fuel position. The controller has a working range of 9-30 Vdc. However, the actuator must be selected for either 12 or 24 Vdc charging system.

2. Select or design a bracket that correctly aligns the actuator shaft and control lever and is able to withstand the vibration level of the engine or application.

3. The linkage must have minimal friction, binding and backlash. The bracket and linkage should be designed to use as much of the actuator travel as possible.

4. Fasten actuator to bracket and bracket to engine. Attach necessary linkage between actuator shaft and fuel control lever. Move linkage end-to-end to confirm correct travel and adjust length if needed.
5. Connect actuator wires (use twisted pair with more than 1 twist per inch). Actuator travel should be adjusted to assure both maximum (start fuel or rated load) and minimum (shutdown or idle) positions.

**NOTE**
It is beyond the scope of this manual to discuss detailed actuator selection and installation procedures for all possible applications. Please contact the factory for specific information concerning your application.

### Engine Protection Input Wiring

**Optional Feature**

The APECS 3000 controller offers an engine protection shutdown feature to safeguard against adverse operating conditions such as low oil pressure or high coolant temperature.

The engine protection (EP) input is a switched input similar to the set speed inputs and is used in lieu of set speed 4 input. The **4-speed mode configuration is not available** when this option is used. The EP input will not interfere with variable speed mode.

The engine protection input must switch to the same potential as the APECS unit. If the APECS is a switch to ground unit, then the engine protection input must also switch to ground. Diagram at right shows how to wire the engine protection input.

To use more than one sensor, simply wire the sensors in parallel.

Once the engine protection input is wired, you must configure the following two calibration parameters to make the feature work.

Set `ENGINE_PROTECT_TIME` to a non-zero value to enable the feature. This is the time, in milliseconds, that the engine protection input must be made before the actuator is shut down. The time you set it to will be dependent on the signal source and the tolerance to the fault condition.

Set `WARMUP_TIME` to an appropriate value. This is the length of time, in seconds, to hold engine at warm up speed immediately after engine has started running. An engine protection shutdown condition is not triggered until the engine has been running longer than `WARMUP_TIME`.

An engine shutdown condition occurs when the engine has been running longer than `WARMUP_TIME`, and the engine protection input has been made longer than `ENGINE_PROTECT_TIME`. At this point, the actuator is shut down (duty cycle goes to zero) and the lamp on the APECS unit flashes code 4. The fault is cleared when the engine is restarted; you do not have to reset the APECS unit.

To disable the engine protection feature set `ENGINE_PROTECT_TIME` to 0.

See Chapter 4, “Diagnostic Calibration Parameters.”
Speed Select Switch Wiring

Optional Feature

The APECS 3000 controller offers a speed select option for multiple speed settings. This is a convenient feature for customers who need more than one speed for engine governing (i.e., idle speed/power speed setting or low power/high power setting).

To incorporate this option, determine the speed mode desired based on your application. The five modes available are Single Speed, Two Speed, Three Speed, Four Speed, or Variable Speed.

After determining the speed mode, select the switch hardware best suited for your application. (Switch hardware is not provided or sold by Woodward.)

Choose a switch designed for low currents (5 to 20 mA). Avoid choosing higher current devices that rely on the current to clean the switch contacts. A dry circuit switch is recommended.

The speed select switch is typically mounted on the control panel but can be mounted in any other suitable location.

Use the accompanying diagrams as a guide for wiring the selected switch to your controller.

**NOTE**
Controllers are available with either “switch to battery” or “switch to ground” input for the speed select switches.

Part No. SA-4450 is switch to Vbat controller for magnetic pickups.
Part No. SA-4451 is switch to ground controller for magnetic pickups.

Once the speed select switch is wired, you need to calibrate “Engine Set Speed Calibration” parameters to make the feature work. Please refer to Table 3 to configure the appropriate parameters according to the selected speed mode.

Switch Wiring

**SINGLE SPEED MODE**

No switch is needed.

Use either switch to Vbat (SA-4450) or switch to ground (SA-4451) controller

Refer to Switch Configuration Mode = 1 in Table 3.
TWO SPEED MODE

A toggle switch is used to select between two set speeds.

Refer to Switch Configuration Mode = 2 in Table 3.

Part No. SA-4450 is switch to Vbatt controller.
Part No. SA-4451 is switch to ground controller.

THREE SPEED MODE

A three position rotary switch is used to select among three set speeds.

Refer to Switch Configuration Mode = 3 in Table 3.

Part No. SA-4450 is switch to Vbatt controller.
Part No. SA-4451 is switch to ground controller.

FOUR SPEED MODE

**4-Speed to Ground**

A 4-position rotary switch with two diodes is used to select among four set speeds.

Refer to Switch Configuration Mode = 4 in Table 3.

**4-Speed to Vbatt**

Typical diodes that can be used with the four speed mode are 1N4001, IN4002 up to 1N4007.
A momentary switch is used to ramp desired engine speed either up or down.

See Switch Configuration Mode = 5 in Table 3.

**Remote Status Lamp Wiring**

**Optional Feature**

A remote status lamp can be wired to the serial communication connector on the controller without the interface module (refer to Chapter 2). This allows the user to install the status lamp in an easily visible location while allowing the controller to be mounted elsewhere.

To wire the status lamp, use a high impedance lamp (LED with series resistor) and connect it to the Vbatt+ pin (red wire in corner pin A) and the Tx pin (Yellow wire in corner pin D) of the calibration tool connector.

**NOTE**

The calibration tool is not available for use while the remote status lamp is connected.

See Chapter 5, “Status Lamp / Fault Codes” for further information.
Chapter 3.
Calibration Tool (ACT) Operation

ACT Installation

ACT Kit Contents
ACT is used for programming (configuring and adjusting) and monitoring the APECS controller with your personal computer. The ACT kit contains the following:

- Software CD-ROM
- Interface module
- RS-232 connecting cable
- CD-ROM Installation Guide

Set-up Requirements

Hardware Requirements

- IBM compatible personal computer equipped with a CD-ROM drive and a serial port with DB-9 connector, capable of 9600 baud communication
- Windows software: 95/98/Me/2000/XP
- 64 MB of available RAM memory and a hard disk with at least 2.0 megabyte of free disk space
- SVGA capable video card and monitor, capable of 256 colors and 800 x 600 display

Software Requirements

- CD-ROM of calibration tool software to run on your personal computer. (CD supplied with ACT kit.)

Hardware Set-up

To connect your PC to the APECS 3000 unit a standard RS-232 nine-pin cable and a proprietary interface module is required. Both are included in the ACT kit.

NOTE
Make sure power to the PC and the APECS unit is off when making connections. The engine may or may not be running.

Connect one end of the RS-232 cable to your PC’s COM port. Connect the other end of the cable to the interface module.

Now connect the interface module to the APECS 3000 unit via the connector on the harness.
Software Set-Up

ACT software can be automatically installed on your hard drive from the CD-ROM supplied with the kit. To install the software on your hard drive, follow the procedures below.

1. Turn on your computer and insert the ACT disk into the CD-ROM drive. The install program should automatically launch. If it does not, open Windows Explorer, go to the CD-ROM drive and double click on the install or setup program.

2. Follow the prompts from the install program. You may select the default directory or specify your own.

3. When installation is complete, you may access the ACT software from the Start Menu or create your own shortcut.

4. The set-up is now complete and you are ready to run ACT.
   - To run the ACT software, please refer to “Basic ACT Operation” below.
   - Put the original CD-ROM in a safe place in case the files on your hard drive are damaged or lost.

Figure 10. ACT System Set-Up

NOTE
Make sure power to the PC and the APECS unit is off when making connections. The engine may or may not be running.
Basic ACT Operation

Running the ACT Software

The ACT software is fairly easy to use. Follow the procedures below to run the program.

1. Make certain that the APECS controller is powered up and connected to the computer’s COM port.

2. If an icon for the calibration tool exists, double click on it to start the ACT software. The license screen will be displayed when the ACT is launched. You must either accept the terms or Cancel, which exits the application.

3. If no icon exists, click on the Start button, highlight “Programs,” find the ACT software and click to start it. Default is Woodward, then select “APECS-EPS Calibration Tool.”

4. Make sure the COM port designation in ACT matches the serial port on the back of your PC.

5. Follow the procedure outlined in the Configure Menu to change the COM port assignment, if needed.

Progress Display Screen

This screen is intended to inform the user of the progress of time-consuming communication procedures. It will close automatically when the procedure is complete.

Moving Around the Software

There are five main menu items available with ACT. Several options are available under each main menu item. The discussion in the following pages assumes the cursor is at the main menu screen.

- Use mouse to select or move around the menu.
- Use left mouse to execute a command or accept a condition.
- Use function key <F1> for HELP.
- A HOT key (highlighted character in a menu item) can also be used to access or activate a menu or sub-menu, e.g. File use <ALT> <F>.
- Click on the box in the upper right hand corner to exit ACT.
ACT Menus & Options

ACT Menu Structure

The ACT has five main menus: File Menu, Calibrate Menu, Monitor Menu, Configure Menu, and Help Menu with several options available under each. A complete discussion of all ACT menus and options is presented in the following pages.

<table>
<thead>
<tr>
<th>MAIN MENU</th>
<th>COMMANDS</th>
</tr>
</thead>
<tbody>
<tr>
<td>FILE MENU</td>
<td>Save APECS Cal to File</td>
</tr>
<tr>
<td></td>
<td>View CAL File Comments</td>
</tr>
<tr>
<td></td>
<td>View Text File</td>
</tr>
<tr>
<td></td>
<td>Convert APECS Cal to Text</td>
</tr>
<tr>
<td></td>
<td>Convert Cal File to Text</td>
</tr>
<tr>
<td></td>
<td>Convert Cal File to Strategy</td>
</tr>
<tr>
<td>CALIBRATE MENU</td>
<td>Change APECS Calibration</td>
</tr>
<tr>
<td></td>
<td>Download Cal FILE to APECS</td>
</tr>
<tr>
<td></td>
<td>Compare APECS Cal to File Cal</td>
</tr>
<tr>
<td></td>
<td>Change APECS Password</td>
</tr>
<tr>
<td></td>
<td>APECS Calibration Wizard</td>
</tr>
<tr>
<td>MONITOR MENU</td>
<td>Parameter View</td>
</tr>
<tr>
<td></td>
<td>Parameter Plot</td>
</tr>
<tr>
<td></td>
<td>Display Faults</td>
</tr>
<tr>
<td></td>
<td>Control Strategy</td>
</tr>
<tr>
<td></td>
<td>Parameter List</td>
</tr>
<tr>
<td>CONFIGURE MENU</td>
<td>Configure Serial Port</td>
</tr>
<tr>
<td>HELP MENU</td>
<td>Help Topics</td>
</tr>
<tr>
<td></td>
<td>About ACT</td>
</tr>
<tr>
<td></td>
<td>User Manuals</td>
</tr>
</tbody>
</table>
File Menu

Purpose

The File Menu allows you to perform operations related to viewing, saving and converting files. The following commands are available under the File Menu.

- Save APECS Cal to File
- View Cal File Comments
- View Text File
- Convert APECS Cal to Text
- Convert Cal File to Text
- Convert Cal File to Strategy

Save APECS Cal to File

This command allows you to save APECS calibration data to a designated file. The ACT uploads the calibration set from the APECS controller and saves it to a computer file. This operation is usually done after the controller has been calibrated for satisfactory engine performance but can also be done at any other time. The data is saved in a binary file format that is not readable.

To Save APECS Cal to File:

1. Choose File → Save APECS Cal to File.

   ACT will prompt the path where the file will be saved:

2. Enter a file name to save the calibration data to.

   ACT will automatically append the file extension .ACT to the file name if you do not specify one. Click Save or press <Enter>.

   ACT will then read all of the current calibration values from the controller. This screen shows the progress.
Once all the values are read, ACT will prompt you to add comments to the ACT file to aid in later identification.

3. If you click Yes, the comment editor screen will appear.

   To enter comments, type them one at a time and press <Enter> or click Save Edit. You can re-edit comments by clicking them, changing the text on the top line and clicking Save Edit. Comments can be deleted by clicking on them and then clicking “Delete” or by pressing <Del>.

4. Click OK on the comment editor or press <Enter> twice to save comments. Click Cancel or press <Esc> twice to close the window without saving comments. The Cal File will still be created if the comment editor is canceled.

5. The following message is displayed when the file is created successfully.

   The file name in this message is the file selected in Step 2. ACT will save the calibration data to the designated file and display “Calibration Data Saved in File: ABCD.ACT” message (where ABCD is the name you entered in Step 2).

NOTE
The “Save APECS Cal to File” command stores the calibration data as an .ACT file that cannot be viewed or printed directly. Viewing and printing must be done from a converted text file. See Convert APECS Cal to Text and Convert Cal File to Text commands.
View Cal File Comments

This command allows you to display the comments that are attached to a calibration file. Users add comments when saving a calibration file. The comments help in tracking specific engine, application, and environment data for which the calibration file was created.

To View Calibration Comments:

- Choose File → View Cal File Comments.
  ACT will display a list of files on the left side of the screen with file comments on the right:

- Use the Up and Down arrow keys to highlight the desired calibration file (.ACT extension) and view the comments attached to that file.

- Click OK or Cancel to close Comment Viewer. The comments are created or edited when the files are created.

View Text File

This command is a convenient way to view text files.

2. ACT will prompt for a text file to view.
3. Select a file and click OK.
4. ACT will open the selected file with the default viewer for that file type.

Convert Commands

The “Save APECS Cal to File” command, discussed earlier, stores the calibration data as an .ACT file that cannot be viewed or printed directly. Viewing and printing must be done from a converted text file.

There are two convert commands available with ACT: “Convert APECS Cal to Text” and “Convert Cal File to Text.” The difference between the two commands is as follows:

1. In “Convert APECS Cal to Text” operation, the calibration set that is converted is from the APECS unit.

2. In “Convert Cal File to Text” operation, the calibration set that is converted is from a previously saved file.

You may use the View Text File command to view text files.
Convert APECS Cal to Text

This command allows you to create a text file of APECS calibration data for viewing or printing from any text editor utility in Windows. A printed copy of the calibration data can be useful for future reference.

To Convert APECS Calibration to Text:

1. Choose File → Convert APECS Cal to Text.
2. ACT will prompt you to enter a name to save the text file. Enter a file and click OK.
   ACT will read all of the calibration values from the controller, create and save a text file with the parameter names, values, and units, then display the file using the default text viewer.

Convert Cal File to Text

This command allows you to convert a previously saved .ACT calibration file to a text file for viewing or printing from any text editor utility in Windows. A printed copy of the calibration data can be useful for future reference.

To Convert Cal File to Text:

1. Choose File → Convert Cal File to Text.
2. ACT will prompt you to enter a name to save the text file. Enter a file and click OK.
   ACT will read all of the calibration values from the controller, create and save a text file with the parameter names, values, and units, then display the file using the default text viewer.

Convert Cal File to Strategy

This command is used to convert old ACT files for use with controllers that have a different control strategy version.

ACT will:
1. Parse through all of the calibration parameters in the old ACT file.
2. Search for the same calibration parameters in the new ACT file and assign values from the old calibration.

To Convert a Cal File to a New Strategy:

2. ACT will prompt you to enter a name to save the text file. Enter a file and click OK.
   ACT will read all of the calibration values from the controller, create and save a text file with the parameter names, values, and units, then display the file using the default text viewer.
Calibrate Menu

The Calibrate Menu allows you to perform operations related to APECS calibration. The following commands are available:

- Change APECS Calibration*
- Download Cal File to APECS*
- Compare APECS Cal to File Cal
- Change APECS Password*
- APECS Calibration Wizard*

(*) These commands can be password protected to prevent unauthorized calibration changes. See “Change APECS Password” for more information.

Change APECS Calibration

The “Change APECS Calibration” command allows you to calibrate (configure and adjust) various parameters associated with the APECS controller.

APECS 3000 is a programmable engine governor. Changing APECS calibration parameters is the means to configure the APECS controller for specific engines, applications and environments, and for adjusting PID gains.

The calibration parameters have been organized into categories for your convenience. Browse through the categories to view the specific parameter you want to change or adjust.

Some parameters must be set before the engine can run. Other parameters can be adjusted while the engine is running. See “List of Parameters” in Chapter 4.

All adjustments are stored immediately in non-volatile memory in the APECS unit. The APECS controller will retain the changes even if power is lost or the ACT is disconnected.

To Change APECS Calibration Parameters:

1. Choose Calibrate → Change APECS Calibration.
2. Set the “View Filter” to select a group of parameters.
3. Use F5/F6 to scroll through the list.
4. To change the highlighted parameter:
   - Enter the new value in the “New Value” field
   - Press <Enter>
   - The new value is written to the controller and then read back, with the result placed in the “APECS Value” field.
5. Press <Esc> to exit.
Download Cal File to APECS

The “Download Cal File to APECS” command allows you to download the entire calibration set from a file to the APECS permanent memory. This is a convenient one-step method for:

- Reverting back to a known good calibration set after experimenting with new calibration settings
- Programming multiple APECS units for a particular application

The downloaded file may have been previously configured and calibrated for satisfactory engine performance with another APECS unit.

To Download a Cal File to APECS:

1. Choose Calibrate → Download Cal File to APECS. The following screen allows you to select a Cal file to download.

2. Choose a file and click OK. The following screen will show the progress.

3. The following screen is shown when the operation is complete.

NOTE
During the “Download Cal File to APECS” operation, the user may encounter a situation where the Cal File password is different from that of the APECS unit. If this happens, please refer to the steps below to complete the download operation.
To Download a Cal File to APECS with a Password Different from that of the APECS Unit:

Whenever the APECS password is added or changed, the new password is stored in the unit as well as in any calibration file saved after the change.

During a “Download Cal File to APECS” operation, if the password stored in the calibration file matches the password in the unit, ACT will readily download the calibration to the APECS unit.

However, if the password stored in the calibration file does not match the password in the APECS unit, ACT will alert you of a password mismatch. Please follow the steps below to complete the download operation.

1. When a password mismatch is detected, the ACT displays a message “Cal File password differs from that of the APECS unit. Download the Cal File password to the APECS unit?”

2. If you answer Yes to this message (see note below), the calibration file will be downloaded and the password in the APECS unit will be changed to match the password stored in the calibration file.

3. If you answer No to this message, the calibration file will still be downloaded but the password in the unit will remain unchanged.

**NOTE**
Before answering Yes to the message, make sure you know the password in the calibration file. If you do not know the password, you will not be able to access the password-protected features under the Calibrate menu.

Please see “Change APECS Password” command for more information on password protection.

**Compare APECS Cal to File Cal**

This command lets you check the differences in calibration sets between a saved file and the APECS unit. The feature is useful, for example, to ensure that the saved file matches the calibration in the APECS unit.

**To Compare APECS Cal to File Cal:**

1. Choose File → Compare APECS Cal to File Cal. This screen allows you to select a Cal File to compare.
2. Choose a file and Click OK. This screen will show the progress.

3. Once all parameters have been processed, a message box will list the compare results. If the parameters in the file match the controller, the following message box appears:

4. Click OK to close. If there were mismatches, the following message will appear:

You may select "Save to File" if you would like to save a permanent record of the file compare. You will then be asked to select a destination directory and file name.
Change APECS Password

This command allows you to add or change a password to protect certain calibration features. The option is useful, for example, to prevent unauthorized changes to a known good calibration set in the APECS unit.

By default, the APECS unit is not password protected.

To Change APECS Password:

1. Choose Calibrate → Change APECS Password. You will be prompted for the current password.

2. The application will query the controller to verify that the entered password matches the current password. If the password matches, the “Change” button is enabled:

3. Click “Change” and the application will prompt for the new password:
4. Enter the new password. It should be one word, no spaces, and up to 11 characters long. Once entered, click OK. The application will prompt to reenter the password to make sure that it was typed in properly:

5. Re-enter the password and click OK. If the two entries of the new password are equal, the new password will be encoded and saved in the controller.

*Passwords are upper and lower case sensitive.*

After changing your password, please record it in a safe place for future reference. To revert to no password protection, change APECS password to “peg,” which is the default password.

**ACT Operation with the New Password:**

Once a password is added or changed, the following calibration features become password protected:

- Change APECS Calibration
- Download Cal File to APECS
- Change APECS Password
- APECS Calibration Wizard

At the start of any future sessions, ACT will always prompt you to enter the new password to gain access to these features. You only need to enter the password once during any session to gain access to all password protected features.

**APECS Calibration Wizard**

The APECS Calibration Wizard is an interactive guide to help you get your controller unit up and running as quickly as possible.

**To Calibrate a Controller Unit Using the APECS Calibration Wizard:**

1. From the main menu, press <C> to open the Calibrate menu.

2. Arrow down to “APECS Calibration Wizard” and press <Enter>.

   The Wizard will inform you if the unit has been previously calibrated or not.

---

**NOTE**

Please be aware that using the Wizard will reset all existing APECS parameters. *If you do not intend to change all parameters, do not use the Wizard.* Manually calibrate only those parameters you intend to change.
3. Press <Enter> to continue or <Esc> to abort the Wizard.

   If you press <Enter> the Wizard will lead you through the calibration process with a series of questions. When all questions have been answered the Wizard will ask you to confirm that the values entered are accurate.

4. Press <Enter> to confirm the values, <PgUp> to go back and change the values, or <Esc> to abort the Wizard.

   If you press <Enter>, the APECS Wizard will download the new calibration and reset all APECS parameters. This will complete the APECS Wizard operation.

   **NOTE**
   The APECS Calibration Wizard only covers basic calibration. It does not automatically assure optimum engine operation. Please refer to APECS Calibration Procedures for more information.

5. You are now ready to run your engine. Press any key to go directly to the Parameter Plot screen where you can adjust the PID gains.

   **Monitor Menu**

   The Monitor Menu allows you to observe engine and APECS operation in real time. The following commands are available under the Monitor Menu.

   - Parameter View
   - Parameter Plot
   - Display Faults
   - Control Strategy
   - Parameter List

   **Parameter View**

   This command allows you to view certain operating variables (i.e., engine speed) in real time.

   **To View Parameter Values in Real Time:**

   1. Choose Monitor → Parameter View. The application will launch the view screen.
   2. The screen automatically starts reading values from the controller and displaying the values.
   3. To stop the updating, click on Stop. The button name will then change to ‘Start.’ Clicking it again will start updating again.

   **NOTE**
   If any other screen is opened that requires communication with the controller while the screen is updating, the Parameter View screen will be automatically stopped.
Parameter Plot

The Parameter Plot command lets you view engine performance on screen in the form of a real-time graph. This feature allows you to perturb the system and observe the response to fine tune engine performance.

To View Parameter Plot in Real Time:

Select Monitor → Parameter Plot. The application will launch and start the parameter plot view.

The application will read the previously saved configuration and request the controller to start sending the parameter values. The controller sends the data to the PC at a rate that varies with the number of parameters being monitored. The application uses the Windows timer functionality to update the screen at the specified rate. Note that if the PC is very busy, the timer accuracy will vary, therefore, the screen and generated data files should be considered as reference only.

The X-axis time scale (25 seconds in the example screen) may be shorter than configured due to the resolution of the monitor. This value will be adjusted when the graph is resized. This also applies to the print functionality for this screen. All of the data will be recorded in a revolving buffer for use by the “Save to File” feature (see below).

The axis scales, parameter names, update resolution and time scale on the Parameter Plot may be changed as described in the Plot Setup screen.

PID Gain Adjustments from Plot Display Screen

After initial calibration, most engines require only a minor adjustment to PID gains to fine tune the system to its optimum level. ACT provides a convenient means of adjusting the PID gains directly from the Plot Display screen.

To Make PID Gain Adjustments from Plot Display Screen:

1. Press the letter <P> for proportional, <I> for integral, or <D> for derivative gain adjustment. The application will enable the gain you selected.
2. Use the Up or Down arrow keys to increase or decrease the present value. The arrow keys adjust the values by 0.004. New values may be typed in directly. Hit <Enter> after you type in a value. The application will save the new value in the APECS unit.
3. Press the <Esc> to deselect the gain adjustments.

To Change Plot Setup:

This allows you to choose engine rpm, desired engine speed, duty cycle or any other parameter for viewing real-time plots on screen. Axis scales can also be adjusted to fit the parameter and/or speed

1. On the Parameter Plot screen, click on “Configure.” The application will show the following screen with the current values.
**Plot 1 / Plot 2**  
Use the pull-down to select the desired parameter to plot.

**Axis Min / Max**  
Enter the minimum / maximum value for the parameter value.

**X Axis Time Scale**  
Controls how much data is displayed on the X axis. This value may automatically adjust for screen resolution.

**X Axis Sample Rate**  
Controls how often the data from the controller is used to update the screen. Data received between timer ticks is discarded.

2. Clicking OK will save this information in the Windows Registry so that it will be remembered the next time the program is started.

**NOTE:** The Calibration Wizard will automatically set up the plots if there are no saved defaults.

### Display Faults

This command allows you to display present faults in real-time. This means if new faults occur while you are monitoring, the screen will automatically update to display the current faults. The display will also show historical fault codes that have been previously logged but do not currently exist. Historical fault codes are helpful when tracking down intermittent faults.

To Display Faults in Real Time:

1. Choose Monitor → Display Faults from the main menu.  
The application will launch the Fault view.

   The application will update the display every time the controller sends the fault_flags status. This happens several times a second.

2. Click on the “Pause” button to stop the automatic update of this screen. The text on the button will change to “Start” and clicking it again will re-start the automatic updating.

**NOTE:** If any other screen requests data from the controller while this screen is updating, this screen will automatically Pause.
Control Strategy

This command allows you to check the version of the control strategy in use. This information may be needed for strategy identification purposes and for future updates.

Parameter List

The Parameter List screen allows the user to adjust which parameters are displayed on the Parameter View display.

To Display the Parameter List:

1. Choose Monitor > Parameter List from the main menu.

2. The F5/F6 keys will backup/advance through the list. Press F9 or click on “On View List” to toggle the selected parameter on the Parameter View screen.

3. Click on the ‘x’ in the title bar or press <Esc> to close the screen. Edits are not saved between application launches.

4. If the Parameter View screen is already open when changes are made to the view list, close the Parameter View screen and re-open it to make the changes effective.

Save

Clicking Save will prompt the user for a file name to save the currently viewed configuration to.

Type in a file name that reflects the purpose of the saved configuration and click Save. The view configuration dialog will now display the selected file name in the title bar.

Open

Clicking Open will prompt the user for a file name of a previously saved View Configuration.

Select the desired file and click Open. The View Configuration will be updated with the saved parameters.

The ACT application will always recall the default set of plot configuration parameters at application startup, and does not recall the last used view setup file. So the view configuration will always start with the default view.

Several parameter view screens can be open with different configurations by changing the configuration on the parameter list screen (F9 or Open), then opening a new Parameter View.
NOTE
Only one of the parameter view screens can be monitoring the controller at once.

Configure Menu

Configure Serial Port

This command allows you to designate the proper COM port for your PC to enable communication between the ACT and the APECS controller.

To Configure the Serial Port:

1. From the main menu screen, choose Configure → Custom Serial Port. The application will display the following screen:

2. Choose a port and Click OK. This screen will be displayed on application startup if a controller cannot be found at the last selected port and can be changed any time after the application has started.

Demo Mode

This mode will use a calibration file “Demo.000” and use random numbers for values requested from the controller.

COM 1 / COM 2

This mode will look for a controller attached to the selected serial port. An error message will be displayed AFTER you click OK if a controller cannot be found or if the port cannot be opened.

COM ports outside of this range can be used by editing the default COM port registry key for this application.
Help Menu

The Help Menu provides access to the online user’s manual and other information helpful to your use of the Calibration Tool. The following commands are available under the Help Menu:

- Help Topics
- About ACT
- User’s Manual

Help Topics

This command allows you to search for specific information by displaying software menu items or through key words.

1. Click on “Contents” for an outline of the software applications listed by menu items.
2. Click on “Index” or “Find” to locate a specific topic through an alphabetical listing or by typing in a word or phrase.
3. Follow the on-screen commands to page through the manual.

About ACT

This command displays the version of the calibration tool that you are currently using. This information is important for tool identification purposes and for servicing support.

User’s Manual

This command accesses the User’s Manual, which includes comprehensive information on the APECS 3000 controller, wiring diagrams, ACT software menus, and calibration parameters. The manual may be viewed online or printed for future reference.
Chapter 4.
Calibration Procedures

Calibration Guide

This section explains the procedures for calibrating (configuring and adjusting) the various APECS 3000 features to work with your application.

Before proceeding, make sure you have installed all the required hardware for your system and are familiar with using the APECS Calibration Tool (ACT).

Safety Precautions

The APECS 3000 is a user configurable engine speed governor and will follow your settings and commands immediately. Please be aware of this when calibrating and entering values in the unit.

It is possible to enter values in the APECS unit that are in excess of what the engine is capable of performing and outside of safe operating range.

It is the user’s responsibility to be accurate when entering data into the APECS or the ACT. Entering values outside of safe operating range can result in serious physical injury and/or damage to the equipment or application.

WARNING
An overspeed shutdown device, independent of the APECS system, should be provided to prevent loss of engine control that may cause personal injury or equipment damage.

Calibrating an APECS Unit

Once the system set-up is complete it is fairly easy to calibrate an APECS 3000 controller.

Before proceeding with calibration, please ensure that the controller unit is connected to the COM port and powered.

Follow the steps below for calibrating your APECS controller unit.

1. If an icon for the Calibration Tool exists, double click on it to start the ACT software.
2. If no icon exists, click on the Start button, highlight “Programs,” find the ACT software and click to start it.
3. Make sure the COM port designation in ACT matches the serial port on the back of your PC.
   Follow the procedure outlined in the Configure Menu to change the COM port assignment, if needed.
4. If you wish to use the Wizard for basic calibration, refer to “APECS Calibration Wizard.” The Wizard is an interactive guide to help you get your controller running as quickly as possible.
5. Beyond basic calibration, there are many parameters associated with APECS that can help enhance the performance of your engine. Read the section on “Understanding APECS Calibration Parameters” and decide on the parameters you would like to adjust.
6. Access “Change APECS Calibration” option from the Calibrate menu and select the desired parameter from the appropriate category. Adjust the value of the parameter as needed.

7. Repeat Step 5 until all desired parameters have been adjusted and satisfactory engine performance has been achieved.

8. You do not need to save the new calibration settings. All settings are automatically saved in the controller and remain in memory after shutdown.

**Saving a Calibration Set to File**

After satisfactory engine performance is achieved, it is recommended that you save the calibration set to a file.

- A saved file allows you to experiment with other calibration settings and still be able to recall the saved calibration set.
- A saved calibration set can be used for configuring additional APECS units.

**To Save a Calibration Set to File:**

1. Access the File Menu to activate the “Save APECS Cal to File” command.
2. Enter a file name to save the calibration data to a designated file.
3. When prompted to edit the comment list, enter information that will help you keep track of specific engine, application and environment data associated with the file.
4. ACT will save the calibration set and automatically append the file extension “.ACT” to the file name.

**Calibrating an APECS Unit with a Saved Calibration File**

You may wish to calibrate additional APECS units with a saved calibration file for consistent, optimized operation.

**To Calibrate an APECS Unit with a Saved Calibration File:**

1. Access the Calibrate menu to activate the “Download Cal File to APECS” command.
2. Select the appropriate file to download (refer to the comment list on the right side of the screen to help identify the desired file). Enter password if prompted. ACT will download file calibration to APECS permanent memory.
3. Repeat Steps 1 and 2 if multiple APECS units are to be calibrated.

**NOTE**

The APECS unit must be powered up, but need not be mounted on the engine to carry out the calibration procedure.
Understanding APECS Calibration Parameters

This section provides answers to frequently asked questions about calibration parameters, lists parameters, and provides calibration procedures.

Frequently Asked Questions

What is a calibration parameter?
A parameter is a numerical value that helps the calibrator adjust or set the APECS controller. Once fixed by a calibrator, the parameter is not subject to change while the system is operating. APECS calibration parameters are used not only to adjust and set the controller but also to configure it properly for different applications.

Why do we need to calibrate the APECS system?
APECS 3000 is a software programmable system and has no manual adjustment. Calibrating is the only means of configuring and adjusting the controller for your specific application.

Do I need to calibrate ALL the parameters to make my system work?
No. Two parameters, PULSES_PER_UPDATE and PULSES_PER_REV, are factory set to prevent the APECS unit from calculating an engine speed and driving the actuators. These two parameters must be calibrated to a non-zero value before normal APECS operation can begin. Other parameters are preset to values that will work with many engines and applications. However, it is recommended that you review all settings for your own application.

Is it possible to enter values in APECS in excess of what the application is capable of performing?
Yes. While ACT (the calibration tool) restricts you from entering values outside of the specified range, the range itself is fairly wide and it is possible to enter values in excess of what your application is capable of performing.

For example, it is possible to command engine speeds up to 8192 rpm with ACT. Your engine may or may not be able to operate at this speed. It is also possible to damage the generator or pump attached to your engine by commanding maximum engine speed because while the engine may be capable of performing at the rated rpm, the generator or pump is likely to have a lower rpm rating than the engine. Furthermore, there are certain parameters that are used to properly configure an application. Entering incorrect values for these parameters will result in improper configuration and may make the engine run at maximum throttle. Entering values outside of safe operating range can result in serious physical injury and/or damage to the equipment.
## List of Parameters

<table>
<thead>
<tr>
<th>CATEGORY</th>
<th>PARAMETER</th>
<th>DESCRIPTION</th>
<th>FACTORY CAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Governor Gain Calibration</td>
<td>DERIVATIVE_GAIN</td>
<td>Speed stability</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>INTEGRAL_GAIN</td>
<td>Steady state speed</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>PROPORTIONAL_GAIN</td>
<td>Transient response</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>RAMP_DOWN_RATE</td>
<td>Engine speed ramp down rate</td>
<td>250</td>
</tr>
<tr>
<td></td>
<td>RAMP_UP_RATE</td>
<td>Engine speed ramp up rate</td>
<td>250</td>
</tr>
<tr>
<td></td>
<td>SET_SPEED_1</td>
<td>Engine set speed 1</td>
<td>1800</td>
</tr>
<tr>
<td></td>
<td>SET_SPEED_2</td>
<td>Engine set speed 2</td>
<td>1900</td>
</tr>
<tr>
<td></td>
<td>SET_SPEED_3</td>
<td>Engine set speed 3</td>
<td>2000</td>
</tr>
<tr>
<td></td>
<td>SET_SPEED_4</td>
<td>Engine set speed 4</td>
<td>2500</td>
</tr>
<tr>
<td></td>
<td>SET_SPEED_MAX</td>
<td>Maximum increment speed</td>
<td>2500</td>
</tr>
<tr>
<td></td>
<td>SET_SPEED_MIN</td>
<td>Minimum decrement speed</td>
<td>1400</td>
</tr>
<tr>
<td></td>
<td>SET_SPEED_WARMUP</td>
<td>Engine warm up speed</td>
<td>1800</td>
</tr>
<tr>
<td></td>
<td>SWITCH_CONFIGURATION</td>
<td>1,2,3,4: multispeed, 5: variable speed</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>WARM_UP_TIME</td>
<td>Time spent at warm up speed</td>
<td>0</td>
</tr>
<tr>
<td>Engine Set Speed Calibration</td>
<td>PULSES_PER_REV</td>
<td>No. of pulses in each sampling period</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>PULSES_PER_SAMPLE</td>
<td>No. of pulses until next engine speed update</td>
<td>0</td>
</tr>
<tr>
<td>Speed Input Configuration</td>
<td>CRANK_DUTY_CYCLE</td>
<td>Kickoff duty cycle for open-loop cranking</td>
<td>0.95</td>
</tr>
<tr>
<td>Engine Start Calibration</td>
<td>CRANK_SPEED</td>
<td>No start to crank mode transition speed</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>RUN_SPEED</td>
<td>Crank to run mode transition speed</td>
<td>700</td>
</tr>
<tr>
<td>Diagnostic Calibration</td>
<td>ENGINE_PROTECT_TIME</td>
<td>Switch delay before engine protection shutdown</td>
<td>1000</td>
</tr>
<tr>
<td></td>
<td>OVERSPEED_RPM</td>
<td>Actuator shutdown speed (max)</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>OVERSPEED_TIME</td>
<td>Delay before overspeed shutdown</td>
<td>150</td>
</tr>
</tbody>
</table>
### Governor Gain Calibration Parameters

**DERIVATIVE_GAIN**
Engine speed governor derivative gain (unitless).

Derivative gain is used to improve stability. Increase derivative gain until response has a slight overshoot on load transients.

**INTEGRAL_GAIN**
Engine speed governor integral gain (unitless).

Integral gain is used to remove steady-state errors. Increase integral gain until speed begins to oscillate, and then decrease until oscillation stops. If oscillations do not occur, bump actuator lever, then decrease integral gain until oscillation stops.

**PROPORTIONAL_GAIN**
Engine speed governor proportional gain (unitless).

Proportional gain is used to improve response time. A maximum amount of proportional gain should be used while still maintaining stability. Increase proportional gain until speed begins to oscillate, then decrease until oscillation stops. If oscillations do not occur, bump actuator lever, then decrease proportional gain until oscillation stops.

ACT allows the user to adjust the P, I, and D gain settings and observe the response directly on screen in the form of a real-time plot. The plots on the following page illustrate the various conditions a user may encounter while tuning an application. Although conditions may vary according to application and nature of load, these plots are typical of what is often observed.

**Figures 11-15** illustrate less desirable conditions often encountered while tuning an application and suggest probable causes.

**Figure 16** shows a plot of a properly tuned application. Although conditions may vary according to application and nature of load, this plot is typical of what is often desired.
PID Gain Settings Response Plots

ACT allows the user to adjust the P, I, and D gain settings and observe the response directly on screen in the form of a real-time plot. The plots on the following page illustrate the various conditions a user may encounter while tuning an application. Although conditions may vary according to application and nature of load, these plots are typical of what is often observed.

![Figure 11. PID Gains Too Low](image1)

![Figure 12. PID Gains Too High](image2)

![Figure 13. Integral Gains Too Low](image3)

![Figure 14. Derivative Gains Too High](image4)

![Figure 15. Integral Gains Too High or Derivative Gains Too Low](image5)

![Figure 16. Desirable Response](image6)

**NOTE**
Excessive friction and slop in the linkage are primary contributors to poor governor stability. If it is not possible to stabilize engine performance, check smoothness of the linkage.
Engine Set Speed Calibration Parameters

**RAMP_DOWN_RATE**
Rate at which commanded engine speed decreases from one set point to a lower set point (rpm/second)

**RAMP_UP_RATE**
Rate at which commanded engine speed increases from one set point to a higher set point (rpm/second)

**SET_SPEED_1**
Preset engine speed 1 (rpm). Used when SWITCH_CONFIGURATION = 1-4

**SET_SPEED_2**
Preset engine speed 2 (rpm). Used when SWITCH_CONFIGURATION = 2-4

**SET_SPEED_3**
Preset engine speed 3 (rpm). Used when SWITCH_CONFIGURATION = 3-4

**SET_SPEED_4**
Preset engine speed 4 (rpm). Used when SWITCH_CONFIGURATION = 4

**SET_SPEED_MAX**
Highest engine speed command possible when using pushbutton switches to ramp engine speed up (rpm). (SWITCH_CONFIGURATION = 5).

**SET_SPEED_MIN**
Lowest engine speed command possible when using variable speed mode to ramp engine speed down (rpm). (SWITCH_CONFIGURATION = 5)

**SET_SPEED_WARMUP**
Engine speed set point used immediately after engine has started running (rpm)

**SWITCH_CONFIGURATION**
This parameter is used to let the software know how the user has configured the speed switch inputs. (See Chapter 2.)

Calibrate SWITCH_CONFIGURATION according to the selected speed mode (see Table 3). There are five switch configurations available.

**WARMUP_TIME**
Length of time to hold engine at warmup speed immediately after engine has started running (seconds). Setting WARMUP_TIME to zero disables the warmup feature.
### Table 3: Switch Configuration Models

<table>
<thead>
<tr>
<th>CONFIGURATION MODE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1: SINGLE SPEED</td>
<td>A single engine speed is commanded. The engine is started and transitions from crank mode to run mode. The commanded engine speed will increase from SET_SPEED_MIN to SET_SPEED_WARMUP at the RAMP_UP_RATE. Engine speed remains at the warm up speed for WARMUP_TIME seconds, after which the engine speed either increases at RAMP_UP_RATE or decreases at RAMP_DOWN_RATE to SET_SPEED_1.</td>
</tr>
<tr>
<td>2: TWO SPEED</td>
<td>A switch is used to select between two set speeds. The engine is started and transitions from crank mode to run mode. The commanded engine speed will increase from SET_SPEED_MIN to SET_SPEED_WARMUP at the RAMP_UP_RATE. Engine speed remains at the warm up speed for WARMUP_TIME seconds, after which the engine speed either increases at RAMP_UP_RATE or decreases at RAMP_DOWN_RATE to the speed selected by the switch (SET_SPEED_1 or SET_SPEED_2). When the other speed is selected with the switch, commanded engine speed is ramped to the new set speed.</td>
</tr>
<tr>
<td>3: THREE SPEED</td>
<td>A rotary switch is used to select among three set speeds. The engine is started and transitions from crank mode to run mode. The commanded engine speed will increase from SET_SPEED_MIN to SET_SPEED_WARMUP at the RAMP_UP_RATE. Engine speed remains at the warm up speed for WARMUP_TIME seconds, after which the engine speed either increases at RAMP_UP_RATE or decreases at RAMP_DOWN_RATE to the speed selected by the rotary switch (SET_SPEED_1 to SET_SPEED_3). When another speed is selected with the switch, the commanded engine speed is ramped to the new set speed.</td>
</tr>
<tr>
<td>Mode</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>4: FOUR SPEED</td>
<td>A rotary switch with two diodes is used to select among 4 set speeds. The engine is started and transitions from crank mode to run mode. The commanded engine speed will increase from SET_SPEED_MIN to SET_SPEED_WARMUP at the RAMP_UP_RATE. Engine speed remains at the warm up speed for WARMUP_TIME seconds, after which the engine speed either increases at RAMP_UP_RATE or decreases at RAMP_DOWN_RATE to the speed selected by the rotary switch (SET_SPEED_1 to SET_SPEED_4). When another speed is selected with the switches, the commanded engine speed is ramped to the new set speed.</td>
</tr>
<tr>
<td>5: VARIABLE SPEED</td>
<td>A momentary switch is used to ramp desired engine speed either up or down. The engine is started and transitions from crank mode to run mode. The commanded engine speed will increase from SET_SPEED_MIN to SET_SPEED_WARMUP at the RAMP_UP_RATE. Engine speed remains at the warm up speed for WARMUP_TIME seconds, after which the user may select a new speed by using the switches, which will either increase or decrease engine speed. A brief pressing of the switch will change engine speed by one rpm. Holding the switch closed longer will ramp the engine speed command, first at a slow rate, then at either RAMP_UP_RATE or RAMP_DOWN_RATE, depending on which direction the switch is being pressed. The engine speed command will never ramp above SET_SPEED_MAX or below SET_SPEED_MIN.</td>
</tr>
</tbody>
</table>
FAQ

Questions About Set Speed Calibration

After a power down/power up reset, does APECS remember the last speed it was using?

No. The only data APECS retains after power down are the calibration parameter settings. If you are using the variable speed mode, you will have to reestablish the desired speed after the engine is restarted.

However, if you are configured for one of the four set speed modes, then APECS will command the same speed on the next power up, after an optional warm up period, as long as the switches haven’t been changed.

If using variable speed mode, what is the initial speed command when the engine starts?

SET_SPEED_WARMUP. Even if WARMUP_TIME is set to 0, this will be the initial engine speed command. It does not change until the engine is running and the toggle switch is pressed. The toggle switch has no effect when the engine is not running.

If using the 4-speed modes, what is the initial speed command when the engine starts?

That depends on your use of a warm up speed. If you’re using a warm up speed, enabled by setting WARMUP_TIME to a non-zero value, then the first speed commanded will be SET_SPEED_WARMUP. If you are not using a warm up speed, disabled by setting WARMUP_TIME to zero, then the first speed commanded is selected by the speed switches.

Can I command the engine to stop without powering down APECS?

Yes, if you are using 2-, 3-, or 4-speed mode. Simply set one of the set speeds to 1. When you select that speed with the switch, the engine will follow the command to 1. Usually powering off the APECS unit shuts down the engine and the throttle is immediately closed. However, if you command a shutdown with the switch, and the ramp down rate is set low, the engine will be stopped in a 'soft shutdown' manner.

When the engine starts, does the desired engine speed jump right to the initial speed command?

No. For a smoother start, desired engine speed ramps to the initial speed command from SET_SPEED_MIN. SET_SPEED_MIN is independent from the other 4 set speeds. It may be set to any value, above or below the other speeds. The recommended value for SET_SPEED_MIN is the low idle speed of the engine. Remember that SET_SPEED_MIN is also the minimum variable speed commanded when lowering engine speed with the toggle switch.

Speed Input Configuration Parameters

PULSES_PER_SAMPLE and PULSES_PER_REV are factory set to prevent the unit from calculating an engine speed and driving the actuator.

These two parameters must be calibrated to a non-zero value before normal APECS operation can begin.

PULSES_PER_SAMPLE

The number of pulses used to calculate engine speed.

PULSES_PER_SAMPLE is factory set to prevent the unit from calculating an engine speed and driving the actuator. This parameter must be calibrated to a non-zero value before normal APECS operation can begin.
In PULSES_PER_SAMPLE the fewer the pulses, the faster the update rate; the greater the pulses, the greater the averaging effect on calculated engine speed.

This number is typically chosen to be the number of pulses in one engine revolution, or the number of pulses in one engine combustion event, whichever is less. For example, if the speed wheel has 96 teeth and the engine has 4 cylinders then there are 48 teeth per combustion event (each combustion event takes 1/2 engine rev).

For spark ignition engines, this number must be between 1 and 4 and is typically set at 1.

**PULSES_PER_REV**
The number of teeth on the engine speed pickup wheel (mag pickup and Hall Effect sensor inputs), or the number of spark pulses per engine rev (ignition input).

To figure out the pulses per revolution you must determine the kind of speed signal input used on your application:

- **Magnetic Pickup Input or Hall Effect Sensor**
Pulses per revolution = number of teeth on the flywheel

- **Woodward Mini-Gen® Signal Generator**
Pulses per revolution = 0.5 x drive ratio if Mini-Gen is driven at other than crankshaft speed

- **Spark Ignition Input**
Pulses per revolution = 1 for single cylinder engine with magneto and one wasted spark

FAQ

**How does PULSES_PER_REV work when using the ignition signal for engine speed?**

When an ignition signal is used to detect engine speed, the input pulses relate directly to cylinder firing events rather than teeth on a flywheel. The controller measures the time between the input pulses from the ignition. To accurately calculate engine speed, it must know how many ignition pulses are occurring in each engine revolution; this is PULSES_PER_REV.

The number of ignition pulses per engine revolution will vary depending on the engine type. Factors that must be known include: how many cylinders the engine has, whether there is a distributor, and if a waste spark is generated.

**Are there any general guidelines?**

Yes. Single cylinder engines typically use a magneto with a firing spark and a wasted spark. The firing spark occurs at the end of the compression stroke, once every 2 engine revs. The wasted spark occurs at the end of the exhaust stroke, 360° later. Therefore, the signal from the ignition will have one pulse per engine revolution. **PULSES_PER_REV = 1.**
With multi-cylinder engines using a distributor, the primary ignition signal will have one pulse for every cylinder-firing event. Since each cylinder is fired every 2 revs, 
PULSES_PER_REV = number of cylinders ÷ 2.
PULSES_PER_REV must be an integer; no half pulses allowed. The ignition signal from a 3-cylinder engine will have 3 pulses per 2 engine revs, which works out to 1.5 pulses per engine rev.

To work around this situation, assign PULSES_PER_REV = 3. Then the calculated engine speed will be exactly half actual speed. If the engine is operating at 1800 rpm, displayed engine speed will be 900 rpm. Therefore all set speeds must be half of the actual target speed.

**CAUTION**
If you forget and set the desired speed to 1800 rpm, the engine will speed up to 3600 rpm in order to reach the target.

### Engine Start Calibration Parameters

**CRANK_DUTY_CYCLE**
The fixed duty cycle used to drive the actuator when the engine is cranking (percent). May be calibrated to a maximum duty cycle for diesel engines that require full rack for starting, or a minimum duty cycle for some spark-ignition engines that require closed throttle for starting.

This parameter is preset to a value that will work with most engines and applications. Entering new values for these parameters is optional.

**CRANK_SPEED**
Speed transition point indicating engine has gone from no-start mode to crank mode (rpm). In no-start mode, the Actuator is not driven. In crank mode, control is open-loop; the actuator is driven with a fixed duty cycle.

This parameter is preset to a value that will work with most engines and applications. Entering new values for these parameters is optional.

**RUN_SPEED**
Speed transition point indicating the engine has gone from crank mode to run mode (rpm). In run mode, control is closed-loop; the actuator is driven as necessary to maintain the set desired engine speed.

### Diagnostics Calibration Parameters

**ENGINE_PROTECT_TIME**
The amount of time spent with the engine protection input made before the actuator is shut down (msec). Setting ENGINE_PROTECT_TIME to a non-zero value activates the engine protection option.

The engine protection input is a switched input such as a low oil pressure sensor. It is connected to both speed switch inputs on the APECS 3000 (see speed switch wiring diagrams in Chapter 2). Using the EP input precludes the use of set speed 4 (switch configuration 4). All other switch configurations are possible.

If the engine has been running longer than WARMUP_TIME, and the engine protection input has been made longer than ENGINE_PROTECT_TIME, then the actuator is shut down and a fault is generated. The lamp on the APECS unit will flash to indicate the fault. The fault is cleared when the engine is restarted.
Set ENGINE_PROTECT_TIME to zero to disable the engine protection option.

OVERSPEED_RPM
Critical engine speed used for overspeed protection (rpm). Set OVERSPEED_RPM to zero if overspeed protection is not desired. Normal closed-loop governing will decrease the duty cycle to the actuator any time engine speed is above the set point. Overspeed protection immediately shuts off the actuator when an overspeed condition is detected. Engine speed must be brought back to zero before the actuator is driven again. Setting OVERSPEED_RPM to zero disables the overspeed protection feature. Default value: 0

OVERSPEED_TIME
Amount of time engine speed must be above OVERSPEED_RPM before overspeed engine protection is activated (seconds).

UNDERSPEED_RPM
Minimum engine speed used for underspeed shut down (rpm). Normal closed-loop governing will increase the duty cycle to the actuator any time engine speed is below the set point. Underspeed shut down immediately shuts off the actuator when an underspeed condition is detected. Engine speed must be brought back to zero before the actuator is driven again. Setting UNDERSPEED_RPM to zero disables the underspeed protection feature.

UNDERSPEED_RUN_TIME
Amount of time the engine must be in run mode before underspeed shut down is activated (sec).

UNDERSPEED_TIME
Amount of time engine speed must be below UNDERSPEED_RPM before underspeed shut down is activated (msec).

FAQ

How does Overspeed Work?
The APECS 3000 has the diagnostic capability to detect and react to an overspeed condition. The feature uses two programmable parameters, OVERSPEED_RPM and OVERSPEED_TIME. Overspeed feature immediately shuts off the actuator when the engine runs above OVERSPEED_RPM for OVERSPEED_TIME.

OVERSPEED_TIME is used to adjust the sensitivity. A large value will delay the shut down, and a small value will hasten it. A value as small as zero can be used, which means that the first occurrence of engine speed being over OVERSPEED_RPM will result in a shut down. This is too sensitive and the engine could be shut down in the unlikely event that noise on the speed signal input caused a high miscalculation of engine speed. A minimum value of 250 msec is recommended. The user should realistically determine an overspeed tolerance time.

When an overspeed condition is detected, the duty cycle goes immediately to zero. Hopefully this will stop the engine. A fault code is generated, and the LED flashes. The fault will continue to flash so that the user is made aware of why the engine stopped. The engine may be restarted without resetting the unit. The fault will then recover and stop flashing.

By default, overspeed is disabled. This is because a properly tuned PID governor will decrease the duty cycle to the actuator any time engine speed is above the set point. So ordinarily, overspeed is not necessary. It is disabled by setting OVERSPEED_RPM to zero. However, if a user feels the need for a more aggressive response to an overspeed condition, the overspeed diagnostic feature may be used.
Actuator Output Calibration Parameter

DUTY_CYCLE_OFFSET
A constant offset added to the governor duty cycle terms to help account for the minimum duty cycle necessary to drive the actuator (percent).
Chapter 5.
APECS Troubleshooting Procedures

General Checklist

Please follow the checklist below to troubleshoot your APECS controller.

We recommend using a digital multimeter capable of measuring frequency and duty cycle such as a Fluke 87.

1. Check battery voltage for stability and correct value.
2. Check that speed signal is at least 2 VRMS using AC volt settings on voltmeter. Actuator should go to full travel during cranking.
3. Check for fault codes (see Table 4).
4. Check linkage for binding and backlash.
5. Check that actuator has sufficient force.
6. Confirm normal operation of engine under manual control.
7. Confirm that load (e.g., voltage regulator on generator) is not inducing instability.
8. Try adjusting gains to achieve stability.

Status Lamp/Fault Codes

The APECS controller is capable of identifying certain fault conditions and alerting the user to them. A flashing LED indicates the fault conditions. The current fault code list is shown in Table IV. Please note the following:

1. When power is first applied to the controller, the LED will flash just once for one second to indicate that the LED is working.
2. If there are multiple faults, the LED will flash them all.
3. If there are no faults, the LED will flash once at reset and from then on indicate the detection of engine speed.
4. The controller will attempt to shut down for all faults and will not permit starting after reset with faults 1, 5 and 6.
### Table 4. Fault Codes

<table>
<thead>
<tr>
<th>FLASH CODE</th>
<th>FAULT</th>
<th>REMEDY</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>APECS unit not calibrated</td>
<td>Calibrate APECS unit.</td>
</tr>
<tr>
<td>2</td>
<td>Engine speed excessive</td>
<td>Check parameter settings. Overspeed criteria may be too sensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Check for electrical noise entering controller.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Check wiring and connections.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Check case ground.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Make sure linkage moves freely, without backlash.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Check tip of speed sensor.</td>
</tr>
<tr>
<td>3</td>
<td>Engine speed unusually low</td>
<td>Check parameter settings.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Check linkage and the actuator travel.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Check load and make sure it is not greater than the capacity of engine.</td>
</tr>
<tr>
<td>4</td>
<td>Engine shutdown due to engine protection input</td>
<td>Check parameter settings.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Check what may have triggered the protection input.</td>
</tr>
<tr>
<td>5</td>
<td>Factory settings lost</td>
<td>If calibration file is available, download calibration file and cycle power again.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If controller still does not work or if no calibration file is available, consult factory.</td>
</tr>
<tr>
<td>6</td>
<td>APECS unit failed</td>
<td>Electrical noise may be entering controller.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Check wiring, shielding and connections to controller.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cycle power to engine.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If controller still does not work consult factory.</td>
</tr>
</tbody>
</table>
Glossary of Technical Terms

**ACT (All-Purpose Calibration Tool) Software**
PC software program for configuring and calibrating the APECS controller

**Actuator**
Device that converts an electrical signal from the APECS controller to an output shaft position

**APECS (Advanced Proportional Engine Control System)**
Engine governing system developed by Woodward

**Cal File**
File containing APECS calibration data

**Cal Tool Version**
The version of calibration tool software in use

**Calibration**
Process of configuring and adjusting the controller to work with a specific application

**Calibration Wizard**
Interactive software guide to help you set up basic calibration and get the controller in operation quickly

**Control Strategy**
The version of software residing in the controller

**Duty Cycle**
Percentage of time a pulse width modulated (pwm) signal remains on

**Parameter**
Numerical value that helps the user calibrate the APECS controller

**PWM (Pulse Width Modulation)**
Means of simulating analog output with a digital device. The PWM duty cycle determines the equivalent analog output: the higher the duty cycle, the higher the equivalent analog output.

**Speed Sensor**
Device such as a magnetic pickup that senses engine speed
Chapter 6.
Service Options

Product Service Options

The following factory options are available for servicing Woodward equipment, based on the standard Woodward Product and Service Warranty (5-01-1205) that is in effect at the time the product is purchased from Woodward or the service is performed:

- Replacement/Exchange (24-hour service)
- Flat Rate Repair
- Flat Rate Remanufacture

If you are experiencing problems with installation or unsatisfactory performance of an installed system, the following options are available:

- Consult the troubleshooting guide in the manual.
- Contact Woodward technical assistance (see “How to Contact Woodward” later in this chapter) and discuss your problem. In most cases, your problem can be resolved over the phone. If not, you can select which course of action you wish to pursue based on the available services listed in this section.

Replacement/Exchange

Replacement/Exchange is a premium program designed for the user who is in need of immediate service. It allows you to request and receive a like-new replacement unit in minimum time (usually within 24 hours of the request), providing a suitable unit is available at the time of the request, thereby minimizing costly downtime. This is also a flat rate structured program and includes the full standard Woodward product warranty (Woodward Product and Service Warranty 5-01-1205).

This option allows you to call in the event of an unexpected outage, or in advance of a scheduled outage, to request a replacement control unit. If the unit is available at the time of the call, it can usually be shipped out within 24 hours. You replace your field control unit with the like-new replacement and return the field unit to the Woodward facility as explained below (see “Returning Equipment for Repair” later in this chapter).

Charges for the Replacement/Exchange service are based on a flat rate plus shipping expenses. You are invoiced the flat rate replacement/exchange charge plus a core charge at the time the replacement unit is shipped. If the core (field unit) is returned to Woodward within 60 days, Woodward will issue a credit for the core charge. [The core charge is the average difference between the flat rate replacement/exchange charge and the current list price of a new unit.]

Return Shipment Authorization Label. To ensure prompt receipt of the core, and avoid additional charges, the package must be properly marked. A return authorization label is included with every Replacement/Exchange unit that leaves Woodward. The core should be repackaged and the return authorization label affixed to the outside of the package. Without the authorization label, receipt of the returned core could be delayed and cause additional charges to be applied.
Flat Rate Repair

Flat Rate Repair is available for the majority of standard products in the field. This program offers you repair service for your products with the advantage of knowing in advance what the cost will be. All repair work carries the standard Woodward service warranty (Woodward Product and Service Warranty 5-01-1205) on replaced parts and labor.

Flat Rate Remanufacture

Flat Rate Remanufacture is very similar to the Flat Rate Repair option with the exception that the unit will be returned to you in “like-new” condition and carry with it the full standard Woodward product warranty (Woodward Product and Service Warranty 5-01-1205). This option is applicable to mechanical products only.

Returning Equipment for Repair

If a control (or any part of an electronic control) is to be returned to Woodward for repair, please contact Woodward in advance to obtain a Return Authorization Number. When shipping the item(s), attach a tag with the following information:

- name and location where the control is installed;
- name and phone number of contact person;
- complete Woodward part number(s) and serial number(s);
- description of the problem;
- instructions describing the desired type of repair.

CAUTION

To prevent damage to electronic components caused by improper handling, read and observe the precautions in Woodward manual 82715, Guide for Handling and Protection of Electronic Controls, Printed Circuit Boards, and Modules.

Packing a Control

Use the following materials when returning a complete control:

- protective caps on any connectors;
- antistatic protective bags on all electronic modules;
- packing materials that will not damage the surface of the unit;
- at least 100 mm (4 inches) of tightly packed, industry-approved packing material;
- a packing carton with double walls;
- a strong tape around the outside of the carton for increased strength.
Return Authorization Number

When returning equipment to Woodward, please telephone and ask for the Customer Service Department [1 (800) 523-2831 in North America or +1 (970) 482-5811]. They will help expedite the processing of your order through our distributors or local service facility. To expedite the repair process, contact Woodward in advance to obtain a Return Authorization Number, and arrange for issue of a purchase order for the item(s) to be repaired. No work can be started until a purchase order is received.

**NOTE**

We highly recommend that you make arrangement in advance for return shipments. Contact a Woodward customer service representative at 1 (800) 523-2831 in North America or +1 (970) 482-5811 for instructions and for a Return Authorization Number.

Replacement Parts

When ordering replacement parts for controls, include the following information:
- the part number(s) (XXXX-XXXX) that is on the enclosure nameplate;
- the unit serial number, which is also on the nameplate.

How to Contact Woodward

In North America use the following address when shipping or corresponding:

Woodward Governor Company  
PO Box 1519  
1000 East Drake Rd  
Fort Collins CO 80522-1519, USA

Telephone: +1 (970) 482-5811 (24 hours a day)  
Toll-free Phone (in North America): 1 (800) 523-2831  
Fax: +1 (970) 498-3058

For assistance outside North America, call one of the following international Woodward facilities to obtain the address and phone number of the facility nearest your location where you will be able to get information and service.

<table>
<thead>
<tr>
<th>Facility</th>
<th>Phone Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brazil</td>
<td>+55 (19) 3708 4800</td>
</tr>
<tr>
<td>India</td>
<td>+91 (129) 230 7111</td>
</tr>
<tr>
<td>Japan</td>
<td>+81 (476) 93-4661</td>
</tr>
<tr>
<td>The Netherlands</td>
<td>+31 (23) 566111</td>
</tr>
</tbody>
</table>

You can also contact the Woodward Customer Service Department or consult our worldwide directory on Woodward’s website (www.woodward.com) for the name of your nearest Woodward distributor or service facility. [For worldwide directory information, go to www.woodward.com/ic/locations.]
Engineering Services

Woodward Industrial Controls Engineering Services offers the following after-sales support for Woodward products. For these services, you can contact us by telephone, by email, or through the Woodward website.

- Technical Support
- Product Training
- Field Service

Contact information:
Phone: +1 (847) 967-7730
Fax: +1 (847) 967-7832
E-mail: info_niles@woodward.com
Website—www.woodward.com/ic

Technical Support is available through our many worldwide locations or our authorized distributors, depending upon the product. This service can assist you with technical questions or problem solving during normal business hours. Emergency assistance is also available during non-business hours by phoning our toll-free number and stating the urgency of your problem. For technical support, please contact us via telephone, email us, or use our website and reference Customer Services and then Technical Support.

Product Training is available at many of our worldwide locations (standard classes). We also offer customized classes, which can be tailored to your needs and can be held at one of our locations or at your site. This training, conducted by experienced personnel, will assure that you will be able to maintain system reliability and availability. For information concerning training, please contact us via telephone, email us, or use our website and reference Customer Services and then Product Training.

Field Service engineering on-site support is available, depending on the product and location, from one of our many worldwide locations or from one of our authorized distributors. The field engineers are experienced both on Woodward products as well as on much of the non-Woodward equipment with which our products interface. For field service engineering assistance, please contact us via telephone, email us, or use our website and reference Customer Services and then Technical Support.
Technical Assistance

If you need to telephone for technical assistance, you will need to provide the following information. Please write it down here before phoning:

**General**
Your Name
Site Location
Phone Number
Fax Number

**Prime Mover Information**
Engine/Turbine Model Number
Manufacturer
Number of Cylinders (if applicable)
Type of Fuel (gas, gaseous, steam, etc)
Rating
Application

**Control/Governor Information**
Please list all Woodward governors, actuators, and electronic controls in your system:

<table>
<thead>
<tr>
<th>Woodward Part Number and Revision Letter</th>
<th>Control Description or Governor Type</th>
<th>Serial Number</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If you have an electronic or programmable control, please have the adjustment setting positions or the menu settings written down and with you at the time of the call.
We appreciate your comments about the content of our publications.
Send comments to: icinfo@woodward.com
Please include the manual number from the front cover of this publication.